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1 PREFACE 

The Bruker Compass LibraryEditor 4.0 application (referred to as ‘LibraryEditor’) is the 
state-of-art Windows XP application for managing mass spectral libraries.  

The LibraryEditor creates and edits the most advanced MS and MSn libraries for use 
with Bruker Compass DataAnalysis. Unlike any other mass spectral library it contains 
mass spectra with full mass precision and essential acquisition parameters. The search 
algorithm from DataAnalysis makes full use of this information. Structural formulas can 
be added to the compounds. LibraryEditor also supports NIST and NIST user libraries 
created by other programs containing spectra from other vendors. 
 
The LibraryEditor Reference Manual describes the menus and commands available in 
LibraryEditor 4.0. For reference on how to work with LibraryEditor 4.0, please refer to 
the LibraryEditor User Manual that is available as PDF document with your installation. 
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2 FILE MENU 

  
Figure 2-1 File menu (for a writable library being active) 

The File menu offers the following commands:  

New  Creates a new library. 
Open  Opens an existing library. 
Refresh Refreshes the active library. 
Close Closes the active library. 
Access NIST Library Accesses an existing NIST user library. 
Import Compound Information Imports the selected compound information into the 

active library. 
Export Compound Information Exports compound information of the active library. 
Import Library  Imports the selected library into the active library. 
Export Library Exports the active library to ASCII Library File 

format (*.library) or Library File format (*.mlb). 
Check Library  Checks and rebuilds the selected user library. 
Properties Shows properties of the active library. 
Recent file Opens the selected recent file. 
Exit Closes LibraryEditor.  
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2.1 New Command 

The New command is used to create a new library of the Libraries Files format (*.mlb) 
which can be used with LibraryEditor.  

Each library must be placed in a separate folder. This is necessary since the various 
data files which are generated during a library set up will have identical names for all 
libraries created except for the library file (*.mlb) whose name you select. Therefore, 
when creating a new library, first set up a new folder with the name of the library you 
want to create and then create the new library and save it in the respective folder. 
 
The command opens the Create New Library dialog. If you have not yet set up a new 
folder for the library you want to create, first create the respective folder. For this, click 

 and enter the name of the new folder. Then open this folder and create the new 
library. 
 

  
Figure 2-2 Create New Library dialog: Creating a new folder for the library to be set 

up 
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Figure 2-3 Create New Library dialog: Creating a library 

Look in and folder list 
Navigate to the drive and folder to which the new library should be saved. If the desired 

folder has not been set up yet, click , enter the new folder name in the appearing 
frame and then double-click the new folder. 

File name 
Enter the name of the new library you want to create. 

Files of type 
Select the file format the new library is to be saved to. 

Library Files (*.mlb). Creates files of the Library Files format. 

Save 
Creates the new library, saves the data files set up for this library to the selected folder 
and opens the new library.  

Shortcuts 

Button:   
Keys: Ctrl+N 
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2.2 Open Command 

The Open command is used to open an existing library having the Library Files format 
(*.mlb). 

The command opens the resizable Open Library dialog, which allows you to specify 
the name and location of the library you want to open. 
 

  
Figure 2-4 Open Library dialog 

Look in and folder list 
Navigate to the drive and folder that contains the library you want to open. Double-click 
the library or select it and click Open.  

File name 
Enter the file name or select it from the folder list. 

Files of type 
Select the type of files to be shown in the folder list. 

Library Files (*.mlb). Lists all files of the Library Files format. 
All (*.*). Lists all files available. 
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Open 
If a library file is selected, it opens the respective library and displays the data of the 
first compound contained in this library. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
 

Shortcuts 

Button:   
Keys: Ctrl+O 

 

2.3 Refresh Command 

The Refresh command is used to refresh the active library. This is required if at least 
two computers within a network access the same library. For example, on computers A 
and B the library X is open; computer A is viewing entries and computer B is writing 
into the library. For computer B, the library is refreshed automatically whereas 
Computer A will see the changes made by computer B not automatically but after 
performing a refresh on the library. Computer A will also see these changes after 
deactivating (= activating another application) and re-activating LibraryEditor since this 
will cause an automatic refresh.  
 

2.4 Close Command 

The Close command is used to close the acitve library. If on closing a library changes 
made to its currently selected compound have not been saved yet, a confirmation 
request appears asking you about saving these changes. After answering this request, 
the respective library is closed.  
 

2.5 Access NIST Library Command 

The Access NIST Library command is used to access the selected NIST user library 
(named 'User.dbu') that does not have the Library Files format (*.mlb) required by 
LibraryEditor yet. Performing this command generates the corresponding *.mlb file 
('library name'.mlb) allowing you to open and process the respective library in Library-
Editor. Information about mass spectrum acquisition (e.g. ion polarity, MS/MS stage, 
precursor ion, product ion) that is stored in the respective NIST user library is entered 
automatically in Acquisition Parameter of the corresponding mass spectrum if Library-
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Editor can read this information from the user library. The generated library automati-
cally gets the name of the folder the User.dbu is contained in (in the example shown 
below this will be 'MSMSLib.mlb'). 
Additionally, you can optionally specify the location of the NIST main library via this 
command. Giving this location will enable chemical structures of the NIST user libraries 
to be resolved from the NIST main library. 

The command opens the Access NIST User Library dialog, which allows you to select 
the user library you wish to get access to. 

  
Figure 2-5 Access to NIST User Library dialog 

Look in and folder list 
Navigate to the drive and folder that contains the user library you want to get access to. 
Double-click the desired User.dbu file or select it and click Open.  
File name 
Automatically contains the file name User.dbu. 
Files of type 
Select the type of files to be shown in the folder list. 

NIST Libraries Files (nist.db;user.dbu). Lists all files of the NIST Libraries Files 
format. 
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Open 
If a folder is selected, opens the folder and displays its contents in the folder list. If a 
user.dbu file is selected and the location of the NIST main library is known, generates 
the corresponding *.mlb file for the selected user.dbu. A dialog informs you about 
successfully creating additional files for accessing NIST (user) library and asks you if 
you want to open the library now. Click Yes if you want to. 

  
Figure 2-6 Information on creation of access file(s) 

If a user.dbu file is selected but the location of the NIST main library has not been spe-
cified yet, the NIST Library dialog appears. Via this dialog, you can enter the location 
of the NIST main library as an option. This allows chemical structures from NIST user 
libraries to be resolved from the NIST main library. For this, enter the respective path or 
click  and select it in the appearing NIST Main Library dialog. Clicking OK saves 
the location of the NIST main library and generates the corresponding *mlb file for the 
selected user library. Clicking Cancel also generates the *.mlb file but does not save 
any NIST main library location. 

  
Figure 2-7 NIST Library dialog 
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2.6 Import Compound Information Command 

The Import Compound Information command to import compound information stored 
in Comma Separated Values Files (*.csv), Tab Separated Values Files (*.tsv) or 
Structure Data File (SDfiles) (*.sdf) file format into the active library. A CSV resp. TSV 
compound information file can contain information about one or several compounds 
concerning e.g. their chemical formula, nominal mass, CAS number, NIST number, UN 
number, synonym(s) or a comment. It must be created meeting specific requirements 
(Section 2.6.1). A SDF compound information is a collection of mol files, which will be 
assigned to compounds by name. 
When importing such a compound information file into the active library, the library is 
searched for all compounds having compound names identically to compound names 
contained in the file. If such a compound is found, its current compound data is sup-
plied or replaced by the new compound information from the imported file. If no such 
compound is found importing of the compound information file will not have any effect 
on the respective library. 
 
The command opens the Import Compound Information dialog, which allows you to 
select the compound information file to be imported into the active library. 

Look in and folder list 
Navigate to the drive and folder that contains the compound information file you want to 
import. Double-click the file or select it and click Open.  

File name 
Enter the file name or select it from the folder list. 

Files of type 
Select the type of files to be shown in the folder list. 

Comma Separated Values Files (*.csv). Lists Comma Separated Values Files. 
Tab Separated Values Files (*.tsv). Lists Tab Separated Values Files. 
Structure Data Files (SDfiles) (*.sdf). Lists Structure Data Files. 
All Files (*.*). Lists all files present. 

Open 
If a compound information file is selected, it imports the respective information into the 
active library and overwrites that existing compound information that corresponds to 
matched compound names by the imported compound information. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
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Figure 2-8 Import Compound Info dialog 
 

2.6.1 Requirements for Creating Compound Information 
Containing *.csv or *.tsv Files 

A compound information containing Comma Separated Values Files (*.csv) or Tab 
Separated Values Files (*.tsv) file must meet specific requirements concerning the data 
that may be contained and how this data has to be entered. 

The first not empty row (which not necessarily must be the first row in the file) has to 
contain a kind of string, which may include the following tokens. These will be recog-
nized neglecting capital/small letters: 
• Name 
• Formula 
• Comment 
• NominalMass 
• CASNo 
• NISTNo 
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• UNNo 
• Synonym 
 
The following rules have to be followed: 
- The first token must be the ‘Name’ token, which, therefore, is mandatory. 
- The ‘Synonym’ token can be contained several times. 
- If the ‘Name’ token is present, multiple times the last token must be ‘Name’ again. 

This will ensure that the corresponding compound will be renamed to the second 
occurrence of ‘Name’. 

- All other tokens are allowed to be present only once. 
- In a *.csv file the tokens must be comma separated, in a *.tsv file tab separated. 

Empty spaces before and after the separators will be neglected. Aside from the 
different separators used *.csv and *.tsv files behave quite equivalent.  

 
For example, a valid CSV format string could look as follows:  

Name, Synonym, casNO, SYNONYM, NAME 

This format string is understood as follows: Subsequently a list of (any number of) rows 
will follow having the following format: First the compound name is given for which all 
following information is to be entered (since it is allowed that several compounds within 
a library have the same compound name the following actions will be performed on all 
compounds of the library having the respective compound name). This is followed by a 
new synonym to be added to the compound’s synonym list if not already present. After 
that a CAS number comes that is to be entered for this compound; if a CAS number is 
already present this will overwrite the previous CAS number. Then an additional syno-
nym follows to be also entered in the synonym list if not already present. Finally, a new 
compound name for the respective compound comes that will replace the old one. 

After this format string row, the program expects any number of rows supplying infor-
mation according to the above format. Intervening empty rows will be ignored. Optional 
entries of the format (exept for the format string and the compound name) can be left 
out. This is a legal possibility to omit entries you do not want to make. Such “empty 
entries” result in the old entries remaining unchanged. For example, a row could look 
as follows:  

Phenol, Hydroxybenzol, , , xyz 

This row will have the following effects: The currently active library is searched for the 
presence of compounds named “Phenol”. Depending on whether such a compound is 
found the following happens:  
- If (a) compound(s) named “Phenol” is/are found, “Hydoxybenzol” is added to all cor-

responding synonym lists if not already present. All “Phenol” entries are renamed to 
“xyz”. Since the entries for CAS number and the second synonym have been left out 
(empty entries), the old CAS number remains unchanged.  
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- If no compound named “Phenol” is found, nothing will happen. No new compound 
named “Phenol” will be added to the library.  

 

2.7 Export Compound Information Command 

The Export Compound Information command is used to export the compound infor-
mation of the active library to Comma Separated Values Files (*.csv) or Tab Separated 
Values Files (*.tsv) format which can be loaded e.g. into Excel. The exported file 
includes information about each compound of the library concerning its name, formula, 
nominal mass, CAS number, and comment, if available. 
 
The command opens the Export Compound Information dialog to select the file 
format and target folder where you want to save the exported file. 
 

 
Figure 2-9 Export Compound Information dialog 
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Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file. 

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the format the compound information should be converted to. 

Comma Separated Values Files (*.csv). Converts to Comma Separated Values 
Files format. 

Tab Separated Values Files (*.tsv). Converts to Tab Separated Values Files format. 
All Files (*.*). Lists all files present. 

Save 
Converts the compound information of the active library into the selected file format 
and saves it under the specified name in the selected folder. If you have chosen an 
already existing file name, confirm the appearing request for overwriting the existing 
file. 

 

2.8 Import Library Command 

The Import Library command is used to import the selected library having the Library 
Files format (*.mlb) into the active library in order to add the compounds and/mass 
spectra contained in the import library to the active library. 

When importing a library into another library, this will result in those compounds of the 
imported library having names not yet contained in the active library are being added to 
the latter as new compound entries whereas the mass spectra of those compounds 
having already existing names are being added as additional spectra to the respective 
existing compounds. To which compound ID’s of the target library new spectra were 
added will be listed at the end of the appearing import progress information. 
 
The command opens the Import Library dialog, which allows you to select the library 
you want to import into the active library.  
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Figure 2-10 Import Library dialog with the library to be imported being selected 

Look in and folder list 
Navigate to the drive and folder that contains the library you want to import. Double-
click the library or select it and click Open.  

File name 
Enter the file name or select it from the folder list. 

Files of type 
Select the type of files to be shown in the folder list. 

Library Files (*.mlb). Lists all files of the Library Files format. 

Open 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
If a library file is selected, it imports the selected library into the active library. Informa-
tion on the import process and progress appears. This dialog lists at its end all com-
pound ID’s of the active library, which got new spectra. To close this information, click 
Close. 



File Menu Bruker Daltonik GmbH 

 LibraryEditor Reference Manual, Version 4.0 2-14 

 

 
Figure 2-11 Information about import process and progress during (above) and after 

import is finished (below) 
 

2.9 Export Library Command 

The Export Library command is used to export the active library to ASCII Library Files 
(*.library) or Library Files (*.mlb) format. 

The ASCII Library Files format (*.library) is fully NIST compatible and, therefore, allows 
for loading the exported library into the NIST. It is almost identical with the ASCII MS 
Spectrum Files format (*.spectrum) with the one difference that the *.library format can 
contain any number of mass spectra but the *.spectrum format only a single one. The 
specification of the ASCII Spectrum Files format (*.spectrum) is given with the descrip-
tion of the Import command from the Spectrum menu. 
 
The command opens the Export Library dialog, which allows you to select the name 
for the library file to be exported and where it is to be saved. 
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Figure 2-12 Export Library dialog 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file. 

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the file format the library should be converted to: 

ASCII Library File (*.library). Converts to ASCII Library File format. 
Library File (*.mlb). Converts to the Library File format. 

Exclude compound information 
If the Library File (*.mlb) format is selected, check this option if compound information 
should be excluded from being exported. This results in the exported library containing 
only compound names but no additional compound information. If this option is not 
checked, full compound information is included. Default is unchecked. 
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Save 
Converts the active library into the selected file format and saves it under the specified 
name in the selected folder. If you have chosen an already existing file name, confirm 
the appearing request for overwriting the existing file. 
 

2.10 Check Library Command 

The Check Library command is used to check and rebuild the selected library having 
the Library Files format (*.mlb). This is required if corresponding error messages have 
appeared when performing library search in DataAnalysis and/or when browsing the 
respective library in LibraryEditor. 
In addition, you can use library check and rebuild to convert libraries created with Libra-
ryEditor 3.1 or below to the new library format supported since LibraryEditor 3.2, which 
provides additional properties for mass spectra. It is recommended to convert existing 
libraries set up with a previous LibraryEditor version (library version number 2.0 or 2.1) 
to the new library format to make use of the new properties additionally available for 
mass spectra. The version number of a library can be examined from the Properties 
command from the File menu. 
Note: A prerequisite is that all installations containing a ‘LibraryEditor’ and all compu-

ters containing mass-spectral libraries are updated at least to ‘esquire 5.2’, 
‘DataAnalysis 3.2’, or ‘LibraryServer 1.2’, including any higher version of those. 

You can also use library check and rebuild to reduce mass spectra consisting of a huge 
number of masses to the most abundant ones. Rebuilding then creates a library con-
taining only spectra with at most the specified number of masses. The number of 
masses a selected spectrum consists of you can examine from the Mass List tab. 
 
Checking and rebuilding a library creates a new, rebuilt library having the version num-
ber 2.2 while the original library is still preserved. Depending on whether the original 
library is writable or read-only, library check and rebuild proceeds as follows: For 
writable libraries, the rebuilt library replaces the original one after this was saved to a 
new backup-subfolder named either ‘BAK’ or ‘BAK_n’ (with n ≥ 2). For read-only 
libraries, the rebuilt library is saved to a new subfolder named ‘YYMMDDhhmmss’ (Y: 
year, M: month, D: day, h: hour, m: minute, s: second) with the original library remain-
ing unchanged. 
If the library you want to check and rebuild is open when check is prompted, the library 
is automatically closed and opened again after rebuild is finished, i.e. after you have 
clicked Close in the Check Library Progress dialog.  
 
The command opens the Check Library dialog, which allows you to select the library 
you want to check.  
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Figure 2-13 Check Library dialog 

Look in and folder list 
Navigate to the drive and folder that contains the library you want to check. Double-
click the desired library file (*.mlb) or select it and click Open.  

File name 
Enter the file name or select it from the folder list. 

Files of type 
Displays the type of files to be shown in the folder list. 

Libraries Files (*.mlb). Lists all files of the Library Files format. 

Limit mass spectra to N most abundant masses 
Check this option if mass spectra should be limited to a specified number of most 
abundant masses and enter the desired number in the box to the right. Default is 
unchecked. Default setting for ‘N’ is ‘250’. 
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Open 
Checks and rebuilds the selected library and creates a new, rebuilt library file. If the 
option for limiting mass spectrum masses is set, the spectra currently containing more 
masses than the maximum number set are reduced to the specified number of most 
abundant masses. 
First a temporary ‘YYMMDDhhmmss’ subfolder is created to which a copy of the origin-
nal library is saved. Then the rebuild is performed. While this process is running, the 
Check Library Progress dialog informs you about the progress of rebuild.  
After rebuild is finished, the new, rebuilt library file is saved according to the status 
(writable or read-only) of the original library. For writable libraries, a backup-subfolder 
of the general name ‘BAK’ or ‘BAK_n’ (n ≥ 2) is created to which a backup of the 
original library is saved. Then the rebuilt library replaces the original library and the 
‘YYMMDDhhmmss’ subfolder is removed. For read-only libraries, the original library 
remains unchanged and the rebuilt library is saved to the ‘YYMMDDhhmmss’ subfolder 
which is kept.  
Click Close to close the dialog. 

 
Figure 2-14 Check Library Progress dialog after rebuild of a writable library has been 

completed 
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2.11 Properties Command 

The Properties command is used to show properties of the active library concerning 
library name and path, status, number of compounds and spectra contained, and ver-
sion number. 

The command opens the Library Properties dialog, which informs you about certain 
properties of the active library. 
 

  
Figure 2-15 Library Properties dialog 

Information about the following library properties is displayed: 

File name 
Displays file name and path of the active library. 

Status 
Displays the status of the library, Read-only or Writable. 

Number of compounds 
Displays the number of compounds currently contained in the library. 

Number of spectra 
Displays the number of spectra currently contained in the library. 

Library version 
Displays the version number of the library. 
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2.12 Recent File List 

You can use the numbers and library file names listed in the recent file list at the 
bottom of the File menu to open quickly one of the last closed libraries. Select the 
number that corresponds to the library file you want to open. 

When pointing on a recent file, corresponding full path name is displayed in a tool tip. 
 

 
Figure 2-16 Tool tip displaying full path name of selected recent file 
 

2.13 Exit Command 

The Exit command closes your current LibraryEditor session. The current user inter-
face settings are automatically stored for the current user logged into Windows. If on 
closing LibraryEditor changes made to the selected compound of the open library have 
not been saved yet, a confirmation request appears asking you about saving these 
changes. After answering this request, LibraryEditor is closed.  

Shortcuts 
Keys: ALT+F4 
Button: Click  or double-click . 
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3 EDIT MENU 

  
Figure 3-1 Edit menu 

The Edit menu offers the following commands: 

Undo  Undoes the last editing action performed on the selected compound of the 
active library. 

Cut  Cuts the current selection in an entry field and puts it onto the Clipboard. 
Copy  Copies the current selection in an entry field and puts it onto the Clipboard. 
Paste  Inserts current Clipboard contents in the selected, editable entry field of the 

active library. 
 

3.1 Undo Command 

The Undo command undoes the last editing action you have performed in an editable 
entry field of the selected compound in the active library. This applies to compound and 
spectrum data fields. 

Shortcut 
Keys: Ctrl+Z 

 

3.2 Cut Command 

The Cut command cuts the current selection in an entry field and puts it onto the 
Clipboard. This applies to compound and spectrum data fields. Using the Paste com-
mand from the Edit menu, you can paste this data to a selected position in an editable 
entry field of the same or another library. 

Shortcuts 

Button:   
Keys: Ctrl+X 
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3.3 Copy Command 

The Copy command copies the current selection in an entry field and puts it onto the 
Clipboard. This applies to compound and spectrum data fields. Using the Paste com-
mand from the Edit menu, you can paste this data to a selected position in an editable 
entry field of the same or another library. 

Shortcuts 

Button:   
Keys: Ctrl+C 

 

3.4 Paste Command 

The Paste command pastes the current Clipboard contents to the selected position in 
an entry field of the active library. This applies to compound and spectrum data entry 
fields. The command will be active for editable entry fields only. 

Shortcuts 

Button:   
Keys: Ctrl+V 
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4 COMPOUND MENU 

  
Figure 4-1 Compound menu 

The Compound menu offers the following commands:  

Find Compound  Searches the active library for the compound specified. 
Import Structure  Imports structure for the selected compound. 
Export Structure  Exports structure of the selected compound. 
Delete Structure  Deletes structure from the selected compound. 
First  Selects the first compound of the active library. 
Previous  Selects the previous compound in the active library. 
Next  Selects the next compound in the active library. 
Last  Selects the last compound of the active library. 
 

4.1 Find Compound Command 

The Find Compound command is used to search the active library for a particular 
compound. The compound can be specified by its compound ID number, one of its 
spectrum ID(s), name, CAS number, nominal mass, chemical formula or UN number.  

This command allows you to select quickly a particular compound, which you know to 
be contained in the active library. In the case of large libraries, this can keep you from 
time-consuming clicking systematic through the compounds contained until you will 
reach the desired one. Additionally, you can search a library for a particular compound 
if you do not know whether it is contained in the respective library. 
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The command opens the Find Compound dialog, which allows you to specify the 
compound you want to find. 
 

  

Figure 4-2 Find Compound dialog 

Select the search criterion to be used to search the active library and enter the desired 
number or name.  
Note: An entry made in one of the text boxes will become effective only if the corre-

sponding option is checked. 

Library 
Displays path and name of the active library. If due to a longer path the library name is 
not shown (completely), click the entry and press the End key to get to the library 
name. 

Compound ID 
(Default) Select this option to search for a compound using a specified compound ID 
number. Enter the respective ID number in the box on the right. 

Spectrum ID 
Select this option to search for a compound using a specified spectrum ID number. 
Enter the respective ID number in the box on the right. 

Name 
Select this option to search for a compound using a specified compound name. Enter 
the respective name in the box on the right. 
With new libraries (library version 2.2 number), the compound search routine also finds 
compounds with similar names. Thus, compounds can be found without their names 
being entered completely and perfectly right. For example, this allows for searching a 
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library for all compound names starting with e.g. “Methyl” or “Desmethyl” (see example 
below) which may be helpful especially when searching larger libraries.  
Also using simple wildcards as well as ‘regular expressions’ (for description see 4.1.1) 
is supported. If you want to use regular expressions, you have to check the Use 
‘regular expressions’ for search by ‘Name’ option. 

CAS number 
Select this option to search for a compound using a specified CAS number. Enter the 
respective CAS number in the box on the right. 

Nominal mass 
Select this option to search for a compound using a specified nominal mass. Enter the 
respective mass in the box on the right. 

Formula 
Select this option to search for a compound using a specified chemical formula. Enter 
the respective formula in the box on the right. 

UN number 
Select this option to search for a compound using a specified UN number. Enter the 
respective UN number in the box on the right.  
Note: This option will be enabled for the original NIST library only. 

Use ‘regular expressions’ for search by ‘Name’ 
Check this option if you want to use ‘regular expressions’ (for description see 4.1.1) for 
compound search by ‘Name’. Default is unchecked. 

OK 
Searches the selected library for the specified compound. Depending on whether one 
or more compounds is/are found which meet(s) the specified criterion one of the follow-
ing occurs: 
• If only one compound is found, this compound is shown in the library window.  
• If more than one compound is found, the Find Compound Result dialog appears 

which lists all compounds found with corresponding Compound ID, Name, CAS 
number and Chemical formula if available. 

 To show one of these compounds, select the desired compound from this list and 
click Show. 
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Figure 4-3 Find Compound Result – ['Criterion': 'entry'(Hits:’number’)] dialog listing 

all compounds found in a search by ‘Name’ meeting the specified crite-
rion und entry 

 
Figure 4-4 Result of compound search by ‘Name’ with using a simple wildcard 

(without Use ‘regular expressions’ for search by ‘Name’ option set) 

• If no compound is found, a corresponding message appears informing you that the 
library 'name' does not contain a compound of the specified criterion 'entry'. On quitt-
ing the message, the Find Compound dialog appears again showing the previous 
search entry. 
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Figure 4-5 Message about named compound is not contained in searched library 

Shortcuts 

Button:   
Keys: Alt+F3 

 

4.1.1 Regular Expressions for Compound Search by 'Name' 

To search for compounds by ‘Name’ you can use ‘regular expressions’ (= special wild-
cards). For this, you have to check the Use ‘regular expressions’ for search by 
‘Name’ option found in the Find Compound dialog. 

Regular expressions represent notations for patterns of text rather than the literal char-
acter. They are a concise and flexible notation for finding patterns of text. The provided 
expressions conform to the POSIX extended syntax, but with locale specific collation 
disabled, and escape characters inside set declarations enabled. Additionally to that, 
the matching is performed case insensitively. 
 
Expressions for matching characters or digits: 
The following expressions can be used to match characters or digits in your search 
string: 

Expression Syntax Description 

Any character . Matches any single character except a line break. 
Maximal — zero or more  * Matches zero or more occurrences of the 

preceding expression. 
Maximal — one or more + Matches at least one occurrence of the preceding

expression. 
Minimal — zero or more ? Matches zero or one occurrences of the 

preceding expression. 
Set of characters [] Matches any one of the characters within the []. To 

specify a range of characters, list the starting and 
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ending character separated by a dash (-), as in [a-
z]. 

Character not in set [^...] Matches any character not in the set of characters 
following the ^. 

Grouping () Groups a subexpression. 
Or | Matches the expression before or after the OR 

symbol (|). Mostly used within a group. For 
example, (sponge|mud) bath matches "sponge 
bath" and "mud bath." 

Escape \ Matches the character following the backslash (\). 
This allows you to find characters used in the 
regular expression notation, such as { and ^. For 
example, \^ Searches for the ^ character. 

Range for the number of 
matches 

{} Matches a range of valid occurrences of the 
preceding expression. 

Alphanumeric character 
in sets 

[:alnum:] [[:alnum:]] matches the expression ([a-zA-Z0-9]). 

Word character [:word:] [[:word:]] matches the expression ([a-zA-Z0-9_]). 
Alphabetic character [:alpha:] [[:alpha:]] matches the expression ([a-zA-Z]). 
Decimal digit [:digit:] [[:digit:]] matches the expression ([0-9]). 
Hexadecimal digit [:xdigit:] [[:xdigit:]] matches any hexadecimal digit character 

([0-9a-fA-F]) 
Blanks [:blank:] [[:blank:]] matches any blank character, either a 

space or a tab. 
Space [:space:] [[:space:]]  matches any whitespace character 

(Space, vertical tab, horizontal tab, form feed, 
newline) 

  
Some useful aliases of regular expressions: 
The following table lists some useful aliases of several regular expressions: 

Expression Syntax Alias 
Decimal digit \d [[:digit:]] 
No decimal digit \D [^[:digit:]] 
Space \s [[:space:]] 
Non-space \S [^[:space:]] 
Word character \w [[:word:]] 
Non-word character \W [^[:word:]] 
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Further explanations: 
The escape "\" character makes the following character to a simple literal and thus 
allows to search for characters which are actually part of the regular expression syntax. 
Special characters which have to be „literalized“ for their search are ".", "|", "*", "?", "+", 
"(", ")", "{", "}", "[", "]", "^", "$" and "\". 
Character classes are denoted using the syntax "[:classname:]" and are valid only 
within a set declaration, for example "[[:space:]]" is the set of all whitespace characters. 

Some examples: 
"ba*" will match all of "b", "ba", "baaa" etc. 
"ba." will match "baa" or "ba5" for example but not "b", "ba", or "baaa"  

(Note: The regular expression "." corresponds to "?" of simple wild-
cards, while the regular expression ".*" corresponds to "*" of 
simple wildcards.) 

"ba+" will match "ba" or "baaaa" for example but not "b". 
"ba?" will match "b" or "ba".  
"ba{2,4}" will match "baa", "baaa" and "baaaa".  
"ba{2,}" will match all of "baa", "baaa", "baaaa","baaaaa", "baaaaaa" etc. 
"a(b|c)" could match "ab" or "ac". 
"abc|def" could match "abc" or "def". 
"(H.*o)\s(p.*e)" could match "Hello people" or "ho pe" for example. (Beware of the case 

insensitiveness and the spaces.) 
 

4.2 Import Structure Command 

The Import Structure command is used to import a chemical structure having the Mol 
Files format (*.mol) for the selected compound. This assigns the respective structure to 
the selected compound and saves it in the active library. After importing, the respective 
structure will be shown in the spectrum display. Once you have imported a structure 
you can export or delete it. 

If a chemical structure is currently assigned to the respective compound, the imported 
structure will overwrite the current one. 

Tip: Alternatively, you can use the Import Compound Information command from 
the File menu to import an appropriate Structure Data Files (*.sdf) file in the 
active library allowing you to assign chemical structures to several compounds in 
the library at once. 
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The command opens the Import Mol File dialog, which allows you to select the *.mol 
file for the compound currently selected in the active library. 
 

  
Figure 4-6 Import Mol File dialog 

Look in and folder list 
Navigate to the drive and folder that contains the *.mol file you want to import. Double-
click the file or select it and click Open. 

File name 
Enter the file name or select it from the folder list. 

Files of type 
Displays the type of files to be shown in the folder list. 

Mol Files (*.mol). Lists all files of the Mol Files format. 

Open 
If a *.mol file is selected, it imports the respective chemical structure, assigns the 
structure to the currently selected compound of the active library and shows it in the 
spectrum display. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
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4.3 Export Structure Command 

The Export Structure command is used to export the chemical structure currently 
assigned to the selected compound to Mol File format (*.mol).  
 
The command opens the Export Mol File dialog, which allows you to select the name 
for the *.mol file to be exported and where it should be saved. 
 

  
Figure 4-7 Export Mol File dialog 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  

File name 
Enter a new file name or select an existing name from the folder list. 

Files of type 
Select the file format into which the structure should be exported: 

Mol File (*.mol). Exports in the Mol File format. 
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Save 
Exports the chemical structure in *.mol file format and saves it under the specified 
name in the selected folder. If you have chosen an already existing file name, confirm 
the appearing request for overwriting the existing file. 
 

4.4 Delete Structure Command 

The Delete Structure command deletes the chemical structure currently assigned to 
the selected compound of the active library.  
 

4.5 First Command 

The First command goes to the first compound in the active library. If changes made to 
the currently selected compound have not been saved yet, first a confirmation request 
appears asking you about saving these changes. After answering this question, the first 
compound appears. 

Shortcuts 

Button:   
Keys: Alt+Home 

 

4.6 Previous Command 

The Previous command goes to the previous compound in the active library. If 
changes made to the currently selected compound have not been saved yet, first a 
confirmation request appears asking you about saving these changes. After answering 
this question, the previous compound appears. 

Shortcuts 

Button:   
Keys: Alt+Left 
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4.7 Next Command 

The Next command goes to the next compound in the active library. If changes made 
to the currently selected compound have not been saved yet, first a confirmation 
request appears asking you about saving these changes. After answering this 
question, the next compound appears. 

Shortcuts 

Button:   
Keys: Alt+Right 

 

4.8 Last Command 

The Last command goes to the last compound in the active library. If changes made to 
the currently selected compound have not been saved yet, first a confirmation request 
appears asking you about saving these changes. After answering this question, the last 
compound appears. 

Shortcuts 

Button:   
Keys: Alt+End 
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5 SPECTRUM MENU 

  
Figure 5-1 Spectrum menu 

The Spectrum menu offers the following commands:  

Import  Imports the selected mass spectrum. 
Export Exports the selected mass spectrum. 
Add  Adds the imported mass spectrum as a new compound entry to 

the library or as a new mass spectrum to the selected compound. 
Save  Saves the changes made to the selected mass spectrum. 
Delete  Deletes the selected mass spectrum from the selected compound, 

which will result in deleting the respective compound from the 
active library if no mass spectrum is left for this compound. 

 

5.1 Import Command 

The Import command is used to import a mass spectrum from the file system in order 
to add this mass spectrum either as a new compound entry to the active library or as 
an additional mass spectrum to a selected compound. You can import mass spectra of 
the ASCII MS Spectrum Files format (*.spectrum) which were exported from either 
DataAnalysis or LibraryEditor or mass spectra of the NIST ASCII MS Spectrum Files 
format (*.msp) which were exported from the NIST main library.  

On importing, the respective mass spectrum is loaded in LibraryEditor without getting 
compound and spectrum ID numbers. Corresponding data is shown in the library win-
dow. A compound name is entered automatically in Name consisting of the name of 
analysis the spectrum derives from and corresponding retention time. If you want to 
add the respective mass spectrum to the active library, you must perform the Add 
command from the Spectrum menu and add the imported spectrum as either a new 
compound entry or a new (additional) mass spectrum to an existing compound. The 
Add command becomes enabled by performing a spectrum import.  
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The command opens the Import Spectrum dialog to select the mass spectrum to be 
imported. 
 

  

Figure 5-2 Import Spectrum dialog 

Look in and folder list 
Navigate to the drive and folder that contains the mass spectrum you want to import. 
Double-click the desired mass spectrum or select it and click Open.  

File name 
Enter the file name or select it from the folder list. 

Files of type 
Select the type of files to be shown in the folder list. 

All Spectrum Files. Lists all files of the following formats. 
ASCII MS Spectrum Files (*.spectrum). Lists all *.spectrum files exported from 

DataAnalysis (for description of file format see 5.1.1). 
NIST ASCII MS Spectrum Files (*.msp). Lists all *.msp files exported from the NIST 

main library. 
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Open 
If a mass spectrum file is selected, it imports the respective mass spectrum into 
LibraryEditor and displays the corresponding data without a Compound ID given and 
with 'unnamed' entered in Name. For adding this new mass spectrum, you have to 
select the Add command from the Spectrum menu. 
If a folder is selected, opens the folder and displays its contents in the folder list. 

Shortcuts 
Keys: Ctrl+I 

 

5.1.1 ASCII MS Spectrum File Format (*.spectrum) 

The ASCII MS Spectrum File format (*.spectrum) is fully compatible to the NIST mass 
spectra file format and has the following specifications: 

Each row of the file is introduced by a special case-insensitive keyword, which is imme-
diately followed by a colon, separating the key from the corresponding value(s). Spa-
ces or other characters between the keyword and the colon are not allowed. Some key-
words can be abbreviated; the optional part is listed in parentheses in the table below. 

The order of the keywords is irrelevant, but the first one must be the Name keyword 
and the last one must be the Num Peaks keyword. Other keywords are optional, but 
may appear only once (except for the Synonym keyword). 

Note: Some keywords accept only predefined arguments, which are listed in braces. 
 
Keyword Description 
Name This entry is required, only ASCII characters between ' ' 

(ASCII no. 32) and '~' (ASCII no. 126) are allowed, see table II 
a below. For Greek characters see table II b below. 

CAS The chemical abstracts registry number (with or without '-'). 
NIST The database entry number of NIST libraries. 
UN The four-digit United Nations number of the compound. 
MW The molecular weight in the sense of a nominal mass (an 

integer number). 
Form(ula) The chemical formula. 
Syn(onym) A synonym for the compound. This entry can appear multiply.
Com(ment) Any comment. 
Struc(ture) The hexadecimally coded structure information of an MDL® 

MOL file, continuously written in the same line. Each single 
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byte value is a two-digit number, where each digit must be a 
hexadecimal number (0..9,A..F,a..f). 
Example: The first five bytes of some arbitrary MDL MOL file 

with the molecule name H2O in the first line should 
start with 

                Structure: 48324F0D0A... 
Cont(ributor) Contributor, recommended as "Name, Organization". 
InstType Type of instrument. Recognized symbols are: {IT, TQ, Q, TOF, 

ICR, FTMS, ESI-TOF}. 
InstName Any description for the instrument. 
IoniMethod Method of ionization. Recognized symbols are: {EI, CI, APCI, 

ESI, nano-ESI, TS, MALDI, CAESIUM, APMALDI, APPI}. 
IonPol(arity) Ion polarity. The following symbols are recognized: {neg or 0

for negative, pos or 1 for positive, -1 for undefined polarity, 
both or 2 for both polarities}. 

MSMS(Stage) An integer number n describing the MSn stage. 
PreIon A comma-separated list of precursor ions in m/z (floating-point 

numbers). Although not obligatory, it is recommended to pro-
vide a list of n-1 precursor ions, if the MSMS stage was speci-
fied to be of order n. 

ProdIon A floating-point number describing the product ion in m/z. 
TrapDrive A floating-point number describing the trap drive value of the 

esquire instruments. 
Skim1 A floating-point number describing the skim 1 value of the 

esquire instruments. 
FragAmpl A floating-point number describing the fragmentation ampli-

tude value in V. 
IsolWidth A floating-point number describing the isolation width value in 

m/z. 
TargetGas Any identifier for the target gas. 
TargetGasPres(sure) A floating-point number describing the target gas pressure in 

hPa. 
ReagentIon Any identifier for the reagent ion. 
ReagentGasPres(sure) A floating-point number describing the reagent gas pressure in 

hPa. 
ColEnergy A floating-point number describing the collision energy in eV. 
PeakWidth A floating-point number describing the original mass spectral 

peak width of the raw spectrum in m/z. 
Refl(ector) Integer number describing the reflector mode as linear {0} or 

reflector {1}. 
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PSD Integer number describing whether the spectrum is a post 
source decay spectrum {0, 1}.  

ChargeDecon(volved) Integer number denoting whether the spectrum has been 
charge deconvoluted into the singly charged state {0, 1}. 

Date Date and time of the analysis given as a local time in the ISO 
8601 format:  
YYYY-MM-DD[T| ]HH:MM:SS[+|-]hh:mm  
Each item is presented as an integer value, hh:mm corre-
sponds to the time offset between local time and the Coordi-
nated Universal Time (UTC), such that UTC = local time -
hh:mm 

Column Any description of the chromatographic column. 
RetTime A floating-point number describing the retention time of the 

spectrum in analysis in seconds. 
SSID Unique software system ID of the analysis (Bruker-specific). 
AnalID Unique ID of the analysis (Bruker-specific). 
AnalName Any descriptive identifier of the analysis. 
Mass(Range) Two comma-separated floating-point numbers describing the 

lowest and the highest mass values of the MS measurement 
range. 

Num( Peaks) This item is obligatory and must be the last one of the list. The 
format is as follows: An integer number of peaks followed by 
pairs of mass (floating-point) and intensity (floating-point) 
values delimited by characters of the set " \n,;:')([]{}". 

 

List of ASCII symbols allowed in the Name field: 
SPACE ! " # $ % & ' ( ) 
* + , - . / 0-9 : ; < 

= > ? @ A-Z [ \ ] ^ _ 
` a-z { | } ~     

 

Greek characters in the Name and Synonym fields can be embedded by placing 
their English transcription between dots: 
.alpha. .beta. .gamma. .delta. .epsilon. .zeta. 

.eta. .theta. .iota. .kappa. .lambda. .mu. 

.nu. .xi. .omicron. .pi. .rho. .sigma. 

.tau. .upsilon. .phi. .chi. .psi. .omega. 
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5.2 Export Command 

The Export command is used to export a single mass spectrum to the ASCII MS 
Spectrum Files format (*.spectrum) to the file system. This e.g. allows importing the 
mass spectrum into another library opened in LibraryEditor. 

The command opens the Export Spectrum dialog to select the name and target folder 
for the mass spectrum to be exported. 
 

 
Figure 5-3 Export Spectrum dialog 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the file format the library should be converted to: 

ASCII MS Spectrum Files (*.spectrum). Converts to the ASCII MS Spectrum Files 
format. 
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Save 
Converts the active mass spectrum into the selected file format and saves it under the 
specified name in the selected folder. If you have chosen an already existing file name, 
confirm the appearing request for overwriting the existing file. 
 

5.3 Add Command 

The Add command is used to add the mass spectrum you have previously imported. 
You can add this spectrum to the active library as either new compound entry or new 
(additional) spectrum for an existing compound. Additionally, you can use this 
command to re-add a previously deleted mass spectrum. This operation is possible 
until you select another compound in the same library. 

On selecting this command, the program first checks whether the active library already 
contains a compound of the specified Name. Depending on the result of checking, one 
of the following appears: 
- If the library does not contain compound of this name, the mass spectrum is added to 

the library as a new compound entry, automatically getting a Compound ID number. 
- If a compound with the same name is found, the Add New Spectrum dialog appears 

informing you that the New compound 'name' already exists in the library and lists 
the respective compounds with their compound IDs and names. In this case, you 
have to decide whether the new mass spectrum is to be added as a new compound 
entry to the library, or as a new mass spectrum to an existing compound, which you 
have to select from the list. 

If the Add New Spectrum dialog appears, define how to add the mass spectrum: 

New compound 
Displays the compound name currently assigned to the mass spectrum to be added.  
If you want to add the mass spectrum as a new compound entry, change the com-
pound name shown and click New. You are also allowed to use the same compound 
name, which will result in two compound entries having the same name. Otherwise, 
leave the entry unchanged. 

(Compound list) 
Lists the compounds currently contained in the active library having the same com-
pound name with the corresponding compound ID in front.  
If you want to add the mass spectrum as a new mass spectrum to an existing com-
pound, select the respective compound from this list and click Add to.  

New 
Adds the mass spectrum as a new compound entry to the library using the compound 
name specified in New compound.  
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Add to 
Adds the mass spectrum as a new spectrum to the compound selected in the com-
pound list. 
 

  
Figure 5-4 Add new spectrum dialog 

Shortcut 

Button:   
 

5.4 Save Command 

The Save command saves the changes made to the selected mass spectrum or com-
pound e.g., by editing a mass spectrum’s Mass List or the compound's synonym list.  

Shortcut 

Button:   
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5.5 Delete Command 

The Delete command is used to delete the selected mass spectrum from the corre-
sponding compound. If the selected mass spectrum is the only mass spectrum avail-
able for this compound, then deleting the mass spectrum will result in deleting the 
compound from the library.  

Deleting a mass spectrum occurs in two steps. By selecting this command, first the 
selected mass spectrum will be removed from the compound it corresponds to but it 
will be put to the memory. This allows you to add the respective mass spectrum back to 
either the compound it derives from or as a new compound entry using the enabled 
Add command from the Spectrum menu, e.g., if you have deleted the respective mass 
spectrum by mistake. Deletion is only completed when you select another compound of 
the active library.  

Selecting this command puts the respective mass spectrum to memory. The compound 
ID number disappears and the Add command becomes enabled. Deletion becomes 
effective on selecting another compound of the active library.  

Shortcut 

Button:   
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6 VIEW MENU 

  
Figure 6-1 View menu 

The View menu offers the following commands:  

Toolbar  Shows/Hides the toolbar. 
Status Bar  Shows/Hides the status bar. 

 

6.1 Toolbar Command 

The Toolbars command hides the toolbar when currently visible or shows it when 
currently hidden.  

 

6.2 Status Bar Command 

The Status Bar command hides the status bar when currently visible or shows it when 
currently hidden. 
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7 WINDOW MENU 

  
Figure 7-1 Window menu 

The Window menu offers the following commands: 

Cascade  Arranges multiple library windows in cascade view. 
Tile  Arranges multiple library windows in tile view. 
Arrange Icons  Arranges the icons of minimized libraries. 
Open library list  Activates the selected library and displays its window on top. 
 

7.1 Cascade Command 

The Cascade command arranges the open library windows currently not minimized in 
cascade view. All windows have the same default size but they are shifted by a title bar 
height and an angle of 45°.The active library displays on top with its title bar being high-
lighted. 

  
Figure 7-2 Two library windows arranged in cascade view 
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7.2 Tile Command 

The Tile command arranges the open library windows currently not minimized in tile 
view. Selecting this command shows the window of the currently active library covering 
the full width of the LibraryEditor's user interface. When you activate another library, 
then its window is laid like a tile onto the window of the previously active library.The 
active library displays on top with its title bar being highlighted. 

  
Figure 7-3 Two library windows arranged in tile view 

7.3 Arrange Icons Command 

The Arrange Icons command arranges the icons of libraries whose windows are 
currently minimized within a straight line at the bottom of the LibraryEditor window.  

  

  
Figure 7-4 Arrangement of icons before (top) and after (bottom) selecting the 

Arrange Icons command 

7.4 Open Library List 

If more than one library is open, you can use the open library list to activate a library 
currently not active. The currently active library is indicated by a check mark in front of 
the library name. Selecting another library from this list activates that library and shows 
its library window according to the current display mode. If you select a library currently 
minimized, this library is shown again either maximized or on top of the other open 
library windows. 
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8 HELP MENU 

  
Figure 8-1 Help menu (when in Compliance mode) 

The Help menu offers the following commands:  

Help Topics  Starts LibraryEditor Help. 
License  Licenses your present LibraryEditor installation and 

displays license information. 
Operator  Logs in the specified operator. 
Lock All Applications  Locks all Bruker Daltonics applications. 
About Compass LibraryEditor  Provides information about your present 

LibraryEditor copy. 
 

8.1 Help Topics Command 

The Help Topics command starts LibraryEditor Help in order to get information about 
specific topics. LibraryEditor Help is used like other help applications running under 
Windows. 

Shortcuts 

Button:   
Key: F1 
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8.2 License Command 

The License command is used to view, add and/or delete licenses for Bruker Daltonics 
applications. The command opens the Bruker Daltonics LicenseManager dialog that 
shows any license currently available for any of the Bruker Daltonics applications and 
how long it will be valid. 

To add a new license, enter the license key you received in New license key and click 
Add. A new line is added to Existing licenses with the key you have entered, the 
product name and the date until the license will be valid. To delete an existing license 
select it in Existing licenses, click Delete and confirm the corresponding request. 

Note: If LibraryEditor is running in Compliance mode, only operators who have the 
special right can add and delete licenses. 

  
Figure 8-2 Bruker Daltonics LicenseManager dialog with 'ESI Compass 1.3' license 

needed for LibraryEditor being present (example) 

New license key 
Enter the submitted license key. This enables the Add button. 

Existing licenses 
Lists already existing licenses. 

License key 
Lists the license keys for the existing licenses. 

Valid until 
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Permanent licenses are indicated as ‘unlimited’.  
For temporary licenses, the date until the respective license is valid is shown. An 
expiration warning will inform you automatically about the forthcoming expiration of a 
temporary license firstly 30 days before the respective expiration will expire. If for one 
product more than one license is present, this warning concerns to the longest valid 
license. An expiration warning will appear once per 24 hours and can be skipped by the 
operator. 

Product name 
Lists the names of the products for which licenses already exist. 

Add 
When in Non-Compliance mode, adds the license key entered in New license key to 
the list of existing licenses and licenses the corresponding product.  
When in Compliance mode, opens the Re-enter Your Password dialog (see below) to 
enter again the password for the current operator account. The license key will be 
added after re-entering the correct password and if the operator has the required right. 
This button becomes enabled after the license key has been entered completely. 

Delete 
When in Non-Compliance mode, deletes the license key selected in the Existing 
licenses list after affirming corresponding confirmation request.  
When in Compliance mode, opens, after affirming confirmation request, the Re-enter 
Your Password dialog to enter again the password for the current operator account. 
The license key will be deleted after re-entering the correct passord and if the operator 
has the required right. 
 
Re-enter Your Password dialog 
This dialog is used to re-enter the password for the current operator account.  

 
Figure 8-3 Re-enter Your Password dialog 

Password 
Enter the password for the current operator account. 

OK 
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If the password is correct for the current operator account and the operator has the 
right to add/delete licenses the entered license key is added to or the selected license 
key is deleted from the LicenseManager’s Existing licenses list.  
If the password is incorrect or the operator does not have the required right, a corre-
sponding error message will inform you.  

 

8.3 Operator Command 

The Operator command is used to change the operator during a running LibraryEditor 
session. When LibraryEditor is running in Compliance mode, you can also use this 
command to change your current password.  

Note: There is always only one operator logged into Bruker Daltonics applications on 
a specific computer at a time. 

 
The command opens the LibraryEditor dialog, which allows you to log in and/or 
change your password. Depending on the current mode, Non-Compliance or Compli-
ance, this dialog looks something different. In Non-Compliance mode, you can log in 
without identifying whereas in Compliance mode you have to identify by operator name 
and password. 
Note: This dialog appears automatically on each start-up of your LibraryEditor appli-

cation unless you are currently logged in another Bruker Daltonics application 
(for both Non-Compliance and Compliance mode) or the corresponding option 
for skipping this dialog is set (for Non-Compliance mode only).  

Operator 
Enter your operator ID. The ID of the current operator will automatically be entered if 
the UserManagement administrator has set the corresponding option. The operator ID 
is not case-sensitive. 

Password 
Enter your password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. Successive wrong inputs will cause locking of 

the operator when the number of wrong login tries exceeds the number of 
wrong logins allowed by the UserManagement administrator. Only the User-
Management administrator can unlock a locked operator. 

Note: This entry field is available in Compliance mode only. 
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Figure 8-4 LibraryEditor dialog for logging in the operator when in Non-Compliance 

mode 

 
Figure 8-5 LibraryEditor dialog for logging in the operator when in Compliance mode  

Always login using this Operator 
Check this option if the operator named in Operator should be logged in automatically. 
This will skip this dialog when starting LibraryEditor in future. 
Note: This check box is available in Non-Compliance mode only. 

Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog (see below). 
Note: This button is available in Compliance mode only. 

Log On 
Logs in the (specified) operator.  
In Compliance mode, log in will be successful only if operator ID and password match. 
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If both do not match an error message will appear. Successive wrong password inputs 
can cause locking of an operator by UserManagement. If a new created operator tries 
to log into a Bruker Daltonics application the first time, the program requires for 
changing the password. Quitting the request opens the Change Password dialog (see 
below). 
 

Change Password dialog 
This dialog is used to change the current password for the operator named in Ope-
rator. The new password must comply with the password policy settings defined by the 
UserManagement administrator. 

 
Figure 8-6 Change Password dialog 

Operator 
Displays the ID of the operator whose password can be changed. If the password for 
another operator should be changed, click Cancel and enter the desired operator in the 
previous dialog. 

Old password 
Enter your current password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. 

New password 
Enter the new password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. Make sure, that the new password complies with 

the current password policy settings. 

Confirm new password 
Confirm your new password. You must enter the same password as above. 

OK 
If the new password and its repetition are the same and the new password complies 
with the current password policy settings, it changes the password. A dialog informs 
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you about successful password change. Quitting this dialog returns you to the Library-
Editor dialog.  
If the new password and its repetition are different or the chosen password does not 
comply with the current password policy settings, a corresponding message appears. 
Quit the message and in the Change Password dialog make again desired entries. 
If the old password is incorrect, a message about denying password change appears. 
Quitting this message returns you to the LibraryEditor dialog. 

   
Figure 8-7 Messages on successful password change (left) and chosen password is 

violating password policy (right) 

 

8.4 Lock All Applications Command 

Note: The Lock All Applications command is available only in Compliance mode. 

The Lock All Applications command is used to lock all Bruker Daltonics applications. 
This includes LibraryEditor as well as all other Bruker Daltonics applications currently 
installed on your system.  

Note: Only the previous operator or someone with the special right to unlock appli-
cations can unlock a locked application.  

Note: Automatic locking of all UserManagement using Bruker Daltonics applications 
will occur if one of these applications has not been used for a certain period 
defined by the UserManagement administrator. 

 
The command opens the LibraryEditor dialog, which informs you that LibraryEditor 
has been locked, by whom (displays the full name of the operator) and how it can be 
unlocked. 
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Figure 8-8 LibraryEditor dialog when LibraryEditor has been locked 

Operator 
Enter the operator ID of the operator who has locked LibraryEditor. The respective 
operator ID will automatically be entered if the UserManagement administrator has set 
the corresponding option. 
If not the previous operator but someone else wants to unlock the applications, enter 
the respective operator ID. 
Note: This respective operator must have the right to unlock applications. 

Password 
Enter the corresponding password. 
Note: Passwords are case-sensitive. Successive wrong password inputs will cause 

locking of the operator. 
Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog. 

Log On 
If operator ID and password match, and the respective operator is allowed to unlock 
applications, it unlocks Bruker Daltonics applications and logs in the specified operator. 
 

Shortcuts 

Button:   
Key: Ctrl+Alt+K 
 



Bruker Daltonik GmbH Help Menu 

LibraryEditor Reference Manual, Version 4.0  8-9

8.5 About Compass LibraryEditor Command 

Use the About Compass LibraryEditor command to display the version number of 
your present copy of LibraryEditor with the copyright notice, the user-specific license 
information, as well as how to contact Bruker Daltonik GmbH. The command opens the 
About Bruker Daltonics LibraryEditor dialog. 
 

  
Figure 8-9 About Bruker Daltonics LibraryEditor dialog 

Shortcut 

Button:   
 



Help Menu Bruker Daltonik GmbH 

 LibraryEditor Reference Manual, Version 4.0 8-10 

 

 



Bruker Daltonik GmbH Index 

LibraryEditor Reference Manual, Version 4.0  I-1

I INDEX 

* 
*.spectrum 5-3 

A 
About Compass LibraryEditor command 8-9 
Access NIST Library command 2-6 
Add command 5-7 
Arrange Icons command 7-2 
ASCII MS Spectrum File format 

(*.spectrum) 5-3 

C 
Cascade command 7-1 
Check Library command 2-16 
Close command (File menu) 2-5 
Compound menu 4-1 
Copy command 3-2 
Cut command 3-1 

D 
Delete command 5-9 
Delete Structure command 4-10 

E 
Edit menu 3-1 
Exit command 2-20 
Export command 5-6 
Export Compound Information  
 command 2-11 
Export Library command 2-14 
Export Structure command 4-9 

F 
File menu 2-1 
Find Compound command 4-1 
First command 4-10 

H 
Help menu 8-1 
Help Topics command 8-1 
 

 

I 
Import command 5-1 
Import Compound Information  
 command 2-8 
Import Library command 2-12 
Import Structure command 4-7 

L 
Last command 4-11 
License command 8-2 
Lock All Applications command 8-7 

N 
New command 2-2 
Next command 4-11 

O 
Open command 2-4 
Open library list 7-2 
Operator command 8-4 

P 
Paste command 3-2 
Previous command 4-10 
Properties command 2-19 

R 
Recent File 2-20 
Refresh command 2-5 
Regular expressions for search by  
 ‘Name’ 4-5 
Requirements for creating compound 

information containing files 2-9 

S 
Save command 5-8 
Spectrum menu 5-1 
Status Bar command 6-1 

T 
Tile command 7-2 
Toolbar command 6-1 



Index Bruker Daltonik GmbH 

 LibraryEditor Reference Manual, Version 4.0 I-2 

U 
Undo command 3-1 

V 
View menu 6-1 

W 
Window menu 7-1 
 

 

 

 

 

 

 

 


	LibraryEditor 4.0 Reference Manual
	Copyright
	Bruker Daltonik GmbH

	Contents
	1 Preface
	2 File Menu
	2.1 New Command
	2.2 Open Command
	2.3 Refresh Command
	2.4 Close Command
	2.5 Access NIST Library Command
	2.6 Import Compound Information Command
	2.6.1 Requirements for Creating Compound Information Containing *.csv or *.tsv Files

	2.7 Export Compound Information Command
	2.8 Import Library Command
	2.9 Export Library Command
	2.10 Check Library Command
	2.11 Properties Command
	2.12 Recent File List
	2.13 Exit Command

	3 Edit Menu
	3.1 Undo Command
	3.2 Cut Command
	3.3 Copy Command
	3.4 Paste Command

	4 Compound Menu
	4.1 Find Compound Command
	4.1.1 Regular Expressions for Compound Search by 'Name'

	4.2 Import Structure Command
	4.3 Export Structure Command
	4.4 Delete Structure Command
	4.5 First Command
	4.6 Previous Command
	4.7 Next Command
	4.8 Last Command

	5 Spectrum Menu
	5.1 Import Command
	5.1.1 ASCII MS Spectrum File Format (*.spectrum)

	5.2 Export Command
	5.3 Add Command
	5.4 Save Command
	5.5 Delete Command

	6 View Menu
	6.1 Toolbar Command
	6.2 Status Bar Command

	7 Window Menu
	7.1 Cascade Command
	7.2 Tile Command
	7.3 Arrange Icons Command
	7.4 Open Library List

	8 Help Menu
	8.1 Help Topics Command
	8.2 License Command
	8.3 Operator Command
	8.4 Lock All Applications Command
	8.5 About Compass LibraryEditor Command

	I Index

